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Micro Focus Visual COBOL 2.3 Update 1 for
ISVs Release Notes
These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.
Note:
•

•

This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.
Check the Product Documentation section of the Micro Focus SupportLine Web site and the Micro
Focus Infocenter for any updates to the documentation which might have been uploaded.

Product Overview
The Micro Focus Visual COBOL for ISVs package comprises the following products which you can
download from your Electronic Product Delivery Note:
•

•

•

Visual COBOL for Visual Studio - delivers the richest development experience for COBOL programming
available on Windows using Microsoft's Visual Studio in one of the following versions 2012, 2013 or
2015. Visual COBOL supports the development and deployment of both managed .NET and native
COBOL applications.
Visual COBOL for Eclipse - provides an Eclipse-based integrated COBOL development environment for
Windows or Linux. Provides COBOL JVM support and enhanced compatibility with ACUCOBOL. Can
be used standalone for developing local applications or in conjunction with the Development Hub to
develop remote projects in Linux and UNIX.
Visual COBOL Development Hub - provides a rich desktop development environment based on the
Eclipse IDE with high-performance server-based tools for managing builds, source code access and
debugger engine. The Development Hub also provides a central administration site, simplifying the
development tool distribution and maintenance process.

Upgrading from earlier Micro Focus products
Application executables that were compiled using earlier Micro Focus products must be recompiled from
the sources using Visual COBOL.
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What's New
This release provides enhancements in the following areas:
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Integration with Visual Studio
Integration with Eclipse
Application Server JCA support for Enterprise Server
Code analysis
Code coverage
Compiler directives
Data File Tools
Database Access - OpenESQL
Dialog System applications
Editor writing assistance
Enterprise COBOL 5.2
File Handling
Library routines
Micro Focus Unit Testing Framework
Managed COBOL syntax
Native COBOL syntax
Rosetta Stone for COBOL, .NET and Java Developers
UNIX and Linux platform support
Windows Azure

Integration with Visual Studio
Back to Top
Support for COBOL in Visual Studio has been enhanced in the following areas:
•
•

•

•

The Go To location and Go To Procedure Division commands are now available from the Edit menu.
In addition, the Go To Procedure Division has a shortcut key - Ctrl+K, Ctrl+J.
Object Browser - now provides support for .NET COBOL code. You can view the members of objects in
your project and the definition of classes and methods as specified by the XML documentation
comments in your code. The window also provides support for the Go To Definition command.
A new search option, Current COBOL Program, has been added to the Find in Files dialog box. This
enables you to search in the COBOL program currently opened in the editor and in any copybooks
referenced by that program.
Solution Explorer - a new context menu command, Add Folder to Copybook Paths, is now available
for the subfolders of your projects. This enables you to add the subfolders to the copybook path of the
project.

COBOL editor:
•

•

•

Line numbers - a new option for configuring the increment for the COBOL and the standard line
numbers when you use Renumber and Unnumber has been added. You can specify the increment from
Tools > Options > Text Editor > Micro Focus COBOL > Line Numbering.
Outlining - a new IDE option enables you to switch outlining in the COBOL editor on or off. See the
Enable Outlining option available on the Advanced page in Tools > Options > Text Editor > Micro
Focus COBOL.
Program breakpoints - a new context menu command, Add COBOL Program Breakpoint, enables you
to set program breakpoints directly from the editor.
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There are new options and new configuration pages in the IDE preferences:
•
•

Autocorrect - a new preferences page in Tools > Options > Text Editor > Micro Focus COBOL.
Quick Actions- a new preferences page in Tools > Options > Text Editor > Micro Focus COBOL
(Visual Studio 2015 only).

Debugging:
•

It is now possible to examine object reference data items as you are debugging native Object Oriented
COBOL applications. The debug tooltip now displays the object's instance data provided that the debug
information for the object's class is available.

Integration with Eclipse
Back to Top
This release provides enhancements in the following areas:
Editor:
•

COBOL editor:
•
•

You can now specify the increment for the COBOL and the standard line numbering from Window >
Preferences > Micro Focus > COBOL > Editor > Line numbering.
You can now toggle single or multiple lines between commented and uncommented states.

Building applications:
•

Environment variables - a new page, Build Environment, in the project's properties enables you to
specify environment variables for your applications. You can also specify environment variables that only
apply at run time on the run or debug configuration for the application.

Application Server JCA support for Enterprise Server
Back to Top
Restriction: This feature applies only when the Enterprise Server feature is enabled.
This release provides support for automatic connection recovery to an active Java application server when
an enterprise server region is restarted. This applies to COBOL resource adapters.
Code analysis
Back to Top
For projects developed with Visual Studio:
This release provides support for performing code analysis at the command line using Microsoft's MSBuild
utility which enables the integration of code analysis in CI frameworks.
Support is available for various MSBuild parameters. You can use MSBuild with the /p switch and with the
following Micro Focus-specific command line options:
•

•
•

RunMicroFocusCodeAnalysisAfterBuild - controls whether code analysis is performed with
MSBuild or not regardless of what code analysis options are specified the project's properties.
ActiveRulesets - specifies which rule sets should be used when running code analysis from the
command line.

For projects developed with Eclipse:
This release provides support for performing code analysis at the command line using Ant which enables
the integration of code analysis in CI frameworks. Features include:
•
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Support for performing code analysis at the command line using the project's .cobolBuild Ant script
and specifying a target.

•
•
•
•
•

New Ant targets for code analysis - analyze and build.and.analyze. These enable you to only run
analysis and produce analysis data or to build and produce build artifacts as well as analysis data.
New Micro Focus Ant task, analysis, for the .cobolBuild file. A parameter for this task enables you
to specify whether the build fails or continues when code analysis results are received.
New parameters for code analysis for the cobol Ant task - analysisData, analysisDataDir.
New Ant type, ruleList, for the .cobolBuild file - enables you to specify the rules to execute.
Support for running analysis using a custom .cobolBuild file from outside of the project directory or
the workspace.

See the Micro Focus Ant User Manual in the Micro Focus Infocenter for more details on the new task, types
and parameters.
Code coverage
Back to Top
The code coverage reports are now integrated with the IDE and with the editor. Features include:
•
•
•

A new Code Coverage view (Eclipse) and Code Coverage window (Visual Studio) showing the statistics
of what percentage of the code has executed.
Navigation from the Code Coverage view (Eclipse) and Code Coverage window (Visual Studio) to the
missed and covered blocks in the editor.
Colorization in the editor of blocks that were executed (covered blocks) or not (missed blocks).

Compiler directives
Back to Top
The following Compiler directives contain new parameters in this release:
•

•

ILMAIN - you now specify the main entry point for the executable program, which can be specified either
as class-name::method-name, or just as method-name. For example, ILMAIN"classA::methodB" or
ILMAIN"methodB". The first format can be used to distinguish between multiple methods with the same
name in different classes.
This directive is now available for JVM COBOL.
OOCTRL - a new parameter, +/-A, as been added. Set this parameter to -A to allow ActiveX controls in
your COBOL application to use classes and methods in the OLE class library. The default is +A, which
does not allow it.

Data File Tools
Back to Top
This release provides improved security and increased support for more file types. Features include:
•

•

•

Certain aspects of Enterprise Server security are honored when you attempt to access data sets. If the
Enterprise Server region has security enabled, logon details must be authenticated before you can
access the data set. If the details are unable to be authenticated, access is denied.
When using a record layout, certain data is now validated at field level (to ensure the contents is
compatible with its picture string ) and record level (to ensure the record length matches the layout
size).
Full editing support has been added for variable block sequential files and relative files. Full editing is
also available for line sequential files, as long as they do not contain any binary data.

Database Access - OpenESQL
Back to Top
This release provides the following new features:

What's New
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•
•

Demonstrations for using OpenESQL in .NET applications. To view these demos, see the SQL
demonstrations in the Visual COBOL Samples browser.
Support for the Oracle fully managed ODP.NET driver.

Dialog System applications
Back to Top
The version of the Compatibility AddPack for Visual COBOL released with Visual COBOL 2.3 Update 1
enables you to give your Dialog System applications a refreshed user interface. Features include:
•

Support for a modern look and feel for Dialog System applications.
Dialog System now supports Microsoft's visual styles for controls and fonts to give your existing Dialog
System applications a modern look that is native to the Windows version the applications are running
on.
You use a new environment variable, MFVSSW, to switch the visual styles on. Alternatively, for
applications that compile to an executable, to switch the new styles, you can add an application manifest
file to the applications' project files.

•

•

See the section Modernizing Dialog System Applications in your product help for details on how to
enable the visual styles, and for information about any possible changes in behavior or appearance of
the common controls.
A modern look and feel of the Dialog System painter.
There are new configuration options in the Dialog System painter for applying the visual styles and fonts
to the painter.
Visual Studio project templates for creating Dialog System applications with a modern look out-of-the
box.
The Compatibility AddPack for Visual COBOL now installs the following new project templates:
•

•

Dialog System Application (Modern) for creating Dialog System applications that use Microsoft's
visual styles by default.
• Dialog System Application (Classic) for creating Dialog System applications that use the classic
fonts and look.
Additional samples:

All of the Dialog System samples previously available with Net Express are now included with the
Compatibility AddPack for Visual COBOL. The samples have been converted to Visual Studio solutions.
For more information see the section Modernizing Dialog System Applications in your product help and the
Release Notes for the Compatibility AddPack for Visual COBOL.
Visual Studio and Eclipse editor coding assistance
Back to Top
This release includes various improvements in the IntelliSense (in Visual Studio) or Content Assist (in
Eclipse) support for COBOL in the following areas:
•
•

Native COBOL - support is now available for OCCURS statements
Managed COBOL - suggestions are now available in the working storage section and in the following
scenarios:
•
•
•
•
•
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Arithmetic expressions in method arguments
Casting variables and some expressions
Creating arrays using the TABLE OF expression and indexers
Generics
Implements and inherits

•
•
•

• Javadoc comments are now displayed (Eclipse)
• Type name filtering in constructs and attributes
• Managed type headers, method heathers and index headers.
• Nested types
• Signature help (Visual Studio)
• SIZE OF expressions
• String concatenations
• TYPE OF constructs
• Unqualified members access - using the SELF:: or SUPER:: syntax
Support for float literals has been enhanced.
Suggestions are now available for more COBOL verbs such as TRY and RAISE (in managed COBOL)
and EXAMINE, INSPECT, SEARCH, GO TO, INITIALIZE, INVOKE, and UNLOCK (in native COBOL).
There are new IDE configuration settings for inserting suggestions and for case handling.

In addition, the Visual Studio editor provides the following new features:
•
•

•

AutoCorrect - you can configure the editor to automatically fix the most frequently misspelled words. You
use the IDE preferences to specify a list of words that you sometimes mistype, and the correct spellings
for them. Whenever you misspell that word, the editor automatically replaces it with correct version.
Light bulbs support in Visual Studio 2015 - there are new quick actions using the light bulb feature that
help you quickly change in the following scenarios:
•

•
•

Convert to COBOL Syntax - offers to convert a .NET type to its equivalent COBOL predefined type.
For example, this will offer an option to convert System.UInt64 to binary-double unsigned.
Converting .NET types to the COBOL predefined types helps you write platform independent
applications which you can easily export from Visual Studio and edit with Visual COBOL for Eclipse.
This quick action is only available for managed COBOL code in the standard or the expanded
copybook view (if it is not in the read-only mode). It is not available in standalone copybooks.
Extract to Copybook - takes the code you have selected in the editor and moves it to a new
copybook file in your project.
Simplify name Type - enables you to simplify the names of .NET types by removing the fully
qualified namespaces when the simplified name can be resolved without ambiguity. For example,
you can change System.String to String.

Enterprise COBOL 5.2
Back to Top
With the introduction of Enterprise COBOL 5.2, the following features are supported:
•
•
•
•

The VOLATILE keyword is supported within the data entry description; although, this is treated as
documentary. It has also become a reserved word when under the ENTCOBOL dialect.
Format 2 of the SORT statement no longer treats the COLLATING SEQUENCE clause as
documentary-only.
The SUPPRESS clause of the XML GENERATE statement has been enhanced.
The IBM z/OS JSON parser API, as documented for the IBM z/OS client web enablement toolkit.

File Handling
Back to Top
The following enhancements have been made to file handling processes:
•

A new indexed file format, IDXFORMAT12, has been introduced to improve file maintenance and
recovery procedures when using the rebuild utility. This file format is similar in structure and use to
IDXFORMAT8. Where the two formats differ is that an IDXFORMAT12 file has an accompanying side
file (.idx file) containing the indexed key information.

What's New
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•

You can use this type of file with the new rebuild /q option. This rebuild process is considerably
quicker than other rebuild processes such as a data scrape or rebuild /p.
Faster SORT operations for fixed block records - when using the DFSORT emulation, the performance
when sorting fixed block records has greatly improved.

Library routines
Back to Top
The following library routines are new in this release:
•
•
•

CBL_CODESET_SET_MAPPING - enables you to change the codeset in effect.
CBL_RUNTIME_ERROR - forces an application to terminate with a run-time error condition.
PC_PRINTER_INFO_DOTNET (.NET COBOL only) - enables the access to the native Hdc for a printer.

Micro Focus Unit Testing Framework
Back to Top
This release provides the following enhancements:
•

Updates to the test runner command line options:
•
•

Using the -testcases: option, you can now specify a list of test cases to execute.
The new -report:markdown option enables you to produce test reports in github style markdown
format (.md).

•

You can use various Third-Party utilities such as pandoc to convert .md files into HTML or PDF
format.
Support for running test suites using dynamic metadata - you use an entry point in the test case and,
when it is called during the preparation stage of the test case, you can change various fields exposed
through mfunit.cpy to update the metadata of the test case.

•

This is an alternative to specifying metadata for a test case in the text fixture file (.mfu).
Support is now available for creating and debugging test cases written in procedural managed COBOL
(procedural code compiled as managed). The following new test runners are supplied:
•
•

mfurunil, for .NET COBOL code
mfurunj (Windows) and cobmfurunj (UNIX) for JVM COBOL code.

Managed COBOL syntax
Back to Top
The following enhancements have been made to the managed COBOL syntax:
•

•
•

A new command line utility, mfjarprogmap, is available for JVM COBOL to allow you to create the
necessary Java property file when calling COBOL programs that have been compiled as part of a
package.
You can now create generic iterators.
You can now use the Profiler utility to obtain detailed statistics on the run-time performance of managed
COBOL applications.

Native COBOL Syntax
Back to Top
The following items are new features of the native COBOL syntax:
Class condition tests New and updated class condition tests are available for DBCS, KANJI, and
JAPANESE.
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RM/COBOL compatibility
Back to Top
The RM/Panels syntax is now supported in Micro Focus COBOL applications.
Rosetta Stone for COBOL, .NET and Java Developers
Back to Top
The product Help now includes a quick and easy to use syntax guide for developers who need to learn OO
COBOL syntax when modernizing COBOL applications for the Java or .NET platforms. The guide includes
side-by-side equivalent syntax for COBOL, C#, VB and Java.
UNIX and Linux platform support
Back to Top
This release is now supported on SUSE and Red Hat platforms that are running the little-endian
PowerLinux architecture.
Note: These are 64-bit platforms only.
There are a few restrictions when running in this environment:
•
•
•
•

The cob flag -p, which enables profiling, is not supported on Red Hat platforms.
The cobmode utility is not supported.
SQL functionality is restricted to OpenESQL support (ODBC and JDBC) only.
The RM File Manager (RMFM) is not supported.

Windows Azure
Back to Top
Visual COBOL support on Microsoft Azure has been updated to version 2.8 of the Microsoft Azure SDK.
Important:
•
•

Starting with this release, versions of the Microsoft Azure SDK earlier than version 2.8 are no
longer supported.
Support for the Microsoft Azure SDK is no longer provided in Visual COBOL for Visual Studio
2012. If you have COBOL Azure projects created with earlier versions of Visual COBOL for Visual
Studio 2012, to maintain them, use Visual COBOL for Visual Studio 2013 or 2015.

What's New
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.
Where present, the numbers that follow each issue are the Support Incident Numbers followed by the
Reported Problem Incident (RPI) number (in parentheses).
•
•
•
•
•
•
•

Data Tools
Dialog System
Editor Writing Assistance
IDE
Run-Time System
SQL: OpenESQL
SQL Option for DB2

Data Tools
Back to the list
•
•
•
•

When filtering a data file, if there is no valid temporary directory set, you are prompted to set one using
the option in the Preferences dialog box.
The editor no longer allows you to open a file if the file size (without header size) is not a multiple of the
record size on disk; an error is produced instead.
The editor no longer allows you to open a file if the file size without header size is not a multiple of the
record size on disk; an error is produced instead.
The level numbers displayed in a record layout correspond to the levels used in the .idy file that was
used when the structure file was created.

Dialog System
Back to the list
•

Versions of the Micro Focus Compatibility AddPack released with version 2.3 of Enterprise Developer or
Visual COBOL 2.3 or with earlier versions supported the use of the "MFOLECL_NO_THREAD_INIT"
environment variable. Using this variable, you could disable the default OLE Class Library COM
threading initialization. This helped avoid issues that could manifest as hangs and crashes, especially
on Microsoft's Windows 8.x or 10 and with applications that are a hybrid between Dialog System, OLE
class library and .NET elements - see http://community.microfocus.com/microfocus/cobol/
visual_cobol/w/knowledge_base/20715.exception-occurs-when-native-dialog-system-program-callsmanaged-winform.aspx.
In the version of the Micro Focus Compatibility AddPack released with Enterprise Developer 2.3.1 or
Visual COBOL 2.3.1, this environment variable is now enabled by default and no longer needs to be set
exclusively. To restore the previous behavior, use a new environment variable,
MFOLECL_THREAD_INIT, and set it to Yes.
2848875 (1102920)

Editor Writing Assistance
Back to the list
•
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•

Pressing TAB in the Visual Studio editor now always inserts the highlighted item in the IntelliSense list
of suggestions.

IDE
Back to the list
•

•

When compiling to multiple executables from the command line, you must specify the -logger parameter
to enable the correct log to be output to the console.
2848855 (1102932)
For a file added to a JVM COBOL project by adding the folder that stores the file (using the Source tab
on the Micro Focus > JVM Build Path > Source page in the projects' properties), there is now a new
context-menu command, Copy to Output Directory, in COBOL Explorer. Choosing this command on a
file triggers a build of the project and copies the file into the output directory.
2699374 (1094326)

Run-Time System
Back to the list
•

The Audit Manager contains a new TIMEOUT option. When a client sends an audit event using the
‘CBL_AUDIT_EVENT’ API, the event gets placed in the next available slot in a shared memory block. If
shared memory is full (i.e. no slots are available), the event is re-tried until a slot becomes available.
If no Audit Manager is running, no events are removed from shared memory, and no slots will ever
become available. Therefore, use the new TIMEOUT option so that a client will only retry sending until
the TIMEOUT duration is reached; after which, it will stop sending audit events. If Audit Manager is
recycled, events will start to be sent again.
To set the TIMEOUT for all Audit Manager clients, specify the following line in the Audit Manager
configuration file:
mfaudit.timeout = n
Where n is the timeout value in milliseconds.
To set the TIMEOUT for an individual Audit Manager client, use the
‘CBL_AUDIT_CONFIG_PROPERTY_SET’ API. It takes an integer property-value, which should be the
timeout value in milliseconds.
If TIMEOUT is set using both methods, the client property TIMEOUT takes precedence, unless this
property is set to zero; in such cases, the TIMEOUT in the configuration file is used. If you use the
‘CBL_AUDIT_CONFIG_PROPERTY_GET’ API on the ‘TIMEOUT’ property, it only returns the
TIMEOUT value for the client property; it does not return the value set in the configuration file.

•

2838689 (1101685)
Several changes have been made to the implementation of IS DBCS, IS KANJI and IS JAPANESE
class condition tests:
•

IS [NOT] DBCS

•

When CHARSET"EBCDIC" is in effect, the IS DBCS test returns true when each character in the
string is deemed to be a valid DBCS character. A valid character has its first byte in the range 0x41
through 0xFE, and the second byte in the range 0x41 through 0xFE, or the character is an EBCDIC
space (0x4040). When CHARSET"ASCII" is in effect, the DBCS test uses an OS call to determine if
the string contains only valid double-byte character, and returns true if valid.
IS [NOT] KANJI
When CHARSET"EBCDIC" is in effect, the IS KANJI test returns true when each character in the
string is deemed to be a valid Kanji character. A valid character has its first byte in the range 0x41
through 0x7F, and the second byte in the range 0x41 through 0xFE, or the character is an EBCDIC
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•

space (0x4040). When CHARSET"ASCII" is in effect, the IS KANJI test uses an OS call to determine
if the string contains only valid Kanji character, and returns true if valid.
IS [NOT] JAPANESE
When CHARSET"EBCDIC" is in effect, the IS JAPANESE test is not supported, and will generate a
COBCH1806 Feature not supported in selected charset message on compilation.
When CHARSET"ASCII" is in effect, the IS JAPANESE test returns true when the string contains
only double-byte Japanese characters or single-byte Japanese Katakana characters, and returns
true if valid. When NSYMBOL"NATIONAL" is in effect, these class tests are not supported, and will
generate a COBCH0303 Operand has wrong data-type message on compilation.

2812895 (1098401)
SQL: OpenESQL
Back to the list
•

The DB2 CONCAT function and operator now convert to SQL Server using the HCOSS-supplied
dbo.CONCAT for character, numeric and datetime data. If you are using BINARY or VARBINARY data,
you must apply the HCOSS-supplied dbo.CONCAT_BINARY function. HCOSS applications deployed
with earlier versions of Enterprise Developer are affected, if they use string or binary concatenation. The
mainframe dialect DB2 || operator and CONCAT function now call a new SQL Server scalar function
dbo.CONCAT(). All existing programs with dialect=mainframe that use DB2 concatenation syntax should
be recompiled. All existing SQL Server databases that are accessed by these programs must have
dbo.CONCAT installed. To create the new function in your application’s SQL Server database, you can
either:
•
•

Run a DSN bind against the customer database. Or:
Execute the %ALLUSERSPROFILE%\Micro Focus\Enterprise Developer\hcoss
\InstallDigitsFunction.sql script.

This is a one-time only change to the database.
2843818 (1102248)
SQL Option for DB2
Back to the list
•

Spurious errors were sometimes returned while querying using an ALIAS.
2830383 (1100609)
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Known Issues
Refer to the Known Errors and Restrictions topic in the Product Information section of your product Help.
In addition, note the following:
Compiler
•

In .NET projects that include multiple COBOL programs, the following sequence of programs can cause
the Compiler to crash:
•
•
•

one or more programs that use COBOL file handling;
a program that does a platform invoke to a native COBOL program;
another program that also uses file handling.

Debugging
•

•

When debugging a remote program, the performance of the network, specifically the latency between
the local and remote machines, will have an effect on the responsiveness of Eclipse. Whenever Eclipse
has to show the new execution position, a number of messages are sent from the remote machine, over
the network, to get the required information. The effect of this is that it can take a few seconds after a
Step command is issued before Eclipse has updated the screen and is ready for the next command.
You can mitigate this delay by closing any unnecessary debug views. For instance, by closing the
Expressions view and the Variables view, the number of messages that are sent is reduced, which
allows Eclipse to update quicker.
Large programs can suffer from a large delay the first time that the program is displayed in the debugger
and an expression is evaluated. You can reduce this delay by following these steps:
1. Create a text file called debugconfig.xml.
2. Add the following lines, and then save the file:

•
•

<?xml version="1.0" encoding="utf-8" ?>
<NativeDebuggerOptions>
<DebugOption Option="REMOTECHECKER" Value="yes"/>
</NativeDebuggerOptions>
3. At a command or shell prompt, set the environment variable DEBUG_CONFIG to the full path name
for debugconfig.xml.
4. Start Eclipse from the same command or shell prompt.
Remote debugging does not work for programs running on AIX or HP machines, if you are trying to
debug using Visual COBOL installed on a Linux machine.
When debugging Object COBOL programs, it is not possible to step into methods if the Visual Studio
Autos window is enabled.

Documentation
•

A known issue in JRE 1.7.0_45 (issue JDK-8028111) causes problems with searching and indexing the
help in the Eclipse help viewer if you are running Eclipse on a machine that has this version of JRE
installed.

Database Access
•

If you have a remote COBOL project under Eclipse that uses DB2 ECM in Visual COBOL or HCO for
DB2 LUW in Enterprise Developer and the DB2 software is not installed on the client machine where
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you are using the Eclipse IDE, you receive background parsing errors in your application. To resolve the
issue, you can do either one of the following:
•
•

Disable background parsing Window > Preferences > Micro Focus > COBOL > Editor and
disabling the checkbox for Background parsing.
Install the IBM DB2 client-side software on the machine on which you are running Eclipse. Go to the
IBM Support Home and locate the page entitled "IBM Download Fix Packs for IBM Data Server
Client Packages" .

Enterprise Server
•
•

The Historical Statistics Facility may generate incorrect records for SSTM-enabled enterprise servers.
On Windows 10, if you are using Microsoft's EDGE browser to access the Enterprise Server
Administration GUI, issues with EDGE can cause the automatic refresh feature to display a dialog
asking whether you want to resubmit a form. To work around this issue, cancel the resubmit request and
then refresh the server list page or the Home page of Enterprise Server Administration. You can also
turn off the automatic refresh by setting the Auto-refresh interval setting on the Home page of
Enterprise Server Administration to 0.

IDE
•

•
•

When you add a COPY statement in a COBOL program and then show it in Expanded Copybook View,
the line for the copybook statement is read-only. If you then perform an Undo in the COBOL program,
the COPY statement is removed while the contents of the copybook is still shown in the program.
Replace All does not work inside the Expanded Copybook View
For copybooks with file extensions that are not traditionally associated with COBOL you must first add
the file extension to the list of known copybooks extensions in Tools > Options > Text Editor > File
Extensions before you can show them in Expanded Copybook View.

Linking
•

Changes in the C compiler in Visual Studio 2015 affect the way you link COBOL object code and C
object code built with that version of Visual Studio in the same executable. In this scenario, you must
use the Microsoft link utility and the C runtime libraries directly from Visual Studio, rather than the Micro
Focus cbllink utility, the Microsoft link utility and the libraries supplied with Visual COBOL. You might
also need to specify some additional C runtime libraries - see the Microsoft documentation for more
details.
Note that when using COBOL and C object code together, Micro Focus recommends you build and
keep the COBOL and C executables separate, and use import libraries and the Micro Focus C functions
for calling COBOL (see "C functions for calling COBOL" in the product help) to resolve calls between
them.

Resource Adapters
•

Trying to deploy the local resource adaptor mfcobol-localtx.rar to WebLogic may fail with a
ClassCastException. To work around this issue, you need to deploy mfcobol-xa.rar first, then need
to undeploy this file and deploy the local one, mfcobol-localtx.rar. If there are issues deploying
using the WebLogic GUI, you can use the command line. If there are issues with this as well, try
reducing the length of the command (for example, by moving the file to a location with a shorter path).

REST/JSON IMTK implementation and the same-origin policy (SOP)
•
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HTTP requests sent from scripts within a web browser to REST services deployed on an enterprise
server might fail due to the same-origin policy (SOP). Some browsers might implement (or support
plugins that implement) techniques for relaxing SOP such as cross-origin resource sharing (CORS) that
enable sending cross-origin requests successfully. For REST services, Enterprise Server does not
implement a method for relaxing SOP. This means that browsers that implement CORS (or any other

SOP relaxation technique) might still forbid requests made from scripts due to Enterprise Server not
implementing the equivalent technique on the server side.

Known Issues
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Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Adis
Character Animator
Code Analysis
Common Communications Interface
Communications Server
Compiler
Data Tools
Debugging
Documentation
Editor Writing Assistance
Enterprise Server
File Handling
IDE
Integrated Preprocessor
Interface Mapping Toolkit
Micro Focus Common Client
Micro Focus Directory Server
Monitoring and Management
Run-Time System
SQL: COBSQL
SQL: DB2
SQL: OpenESQL
SQL Option for DB2
XML Support

Adis
Back to the list
•

Deleting a DBCS character no longer causes corruption when the ADISCF options 15 Pre Clear and 29
Read Screen are specified.
2848637 (1102857)

Character Animator
Back to the list
•

Breakpoints set on paragraphs or sections can now be unset.

•

2845763 (1102710)
Breakpoints are saved correctly when Animator is detached.

•

2842488 (1102878)
Failure to detach the Animator from a process no longer results in the breakpoints being lost.
2842488 (1102117)
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Code Analysis
Back to the list
•
•

The GO TO statement in the analysis result now has a valid sequence line.
Handling for TRY-CATCH-FINALLY code block has been implemented. An issue with Level 78 constant
declared in linkage section has been fixed.

Common Communications Interface
Back to the list
•

•

•

The performance of Fileshare servers on Linux and UNIX platforms has been substantially improved
since the 2.2 Update 2 and 2.3 releases of Visual COBOL and Enterprise Developer.
2829622 (1101067)
On UNIX, the product previously was looking for the cciusers.dat file (used for the initial population of
the MFDS Internal Security users and groups) in the /etc/ folder. Starting with this release, the
cciusers.dat file in $COBDIR/etc/ is used in preference. This removes the requirement to store
cciusers.dat in the /etc directory.
Components that use the SSL/TLS support in CCI, such as Fileshare and MFDASMX, can now use
private key files in binary (DER) format.

Communications Server
Back to the list
•

The Enterprise Server EZ Sockets feature no longer fails to initialize at system startup if the MFCS
connection to MFDS is unusually delayed.
2847439 (1102743)

Compiler
Back to the list
•

The expression 'instance of type com.microfocus.cobol.program.Reference' (or the .NET equivalent) no
longer produces unverifiable code in either JVM COBOL or .NET COBOL.

•

2844614 (1102378)
OSVS report writer programs now compile as expected.

•

2848192 (1102831)
SQL programs containing procedural $SET CONSTANT directives now compile as expected.

•

•

2847029 (1102768)
Passing variable length groups to a user defined function now produces correct object code, which
executes as expected.
2845100 (1102408)
An implicit definition of a VALUE OF FILE-ID, that is, when the program does not declare the data-name
specified in the VALUE OF FILE-ID clause, has been fixed. Previously, the implicit definition was being
made external when it should not have been.

•

2844151 (1102278)
COPY statements that span multiple lines no longer stop REPLACE operations from working as
expected.

•

2843367 (1102672)
A REPLACE statement that acts upon a literal containing a continuation character, where the literal also
contains quotation marks that start and end on different lines, now compiles as expected.
2841444 (1102573)
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•

•

2841281 (1101930)
COBOL applications using ActiveX controls need to add the -A option to the OOCTRL Compiler
directive in order to invoke methods in the ActiveX control.

•

2840671 (1101874)
In the execution of an XML GENERATE statement, the '&' character is now replaced as expected, even
when the associated field is numeric.

•

2839493 (1101911)
Warning message "COBCH0990W No period following EXEC SQL INCLUDE END-EXEC. DB2
coprocessor will fail" is now restricted to mainframe dialects only.

•

2833943 (1101053)
Alphanumeric ACCEPT statements that specify the CONVERT phrase, under RM(ANSI), now work as
expected.

•

2833548 (1100998)
A DBCS name specified as an EXTERNAL ASSIGN name in a SELECT statement is now processed as
expected.

•

2833547 (1100996)
A DISPLAY of a national literal now executes as expected.

•

2833546 (1100995)
A DISPLAY of the result of the DISPLAY-OF intrinsic function with a national literal argument now
executes as expected.

•

2833544 (1100994)
The HOSTRW directive no longer truncates Report Writer files when there is no RECORD CONTAINS
clause in the FD for the report file.

•

2826147 (1100638)
A program compiled with a mainframe dialect that contains a source line with non-ASCII characters in
Area C no longer incorrectly receives the flag message "COBCH1082S Source line is too long".

•

2809384 (1097885)
An ALTER statement on a paragraph defined in a previous section, which also had an ALTER statement
on that paragraph name, now executes as expected.

•

•

•
•

•
•
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COPY REPLACING now correctly affects a REPLACE statement, even if a REPLACE statement is
already active.

| Resolved Issues

2514516 (1079210)
The informational message "COBCH1210 COMP processed as DISPLAY (future occurrences not
indicated)" has been fixed so that it is produced based on the COMP directive setting and not the
DIALECT setting.
A COBRT114 error in generated code on Itanium platforms, for extremely large programs (> 2^24 bytes)
has been fixed.
2844642 (1102395)
A link error "fatal error LNK1190" when compiling to an executable on 64 bit Windows no longer occurs.
2843600 (1102215)
A bug in generated code on Intel-x86 32-bit platforms, when generated with opt (4), which caused an
infinite loop, has been fixed. The bug affected SORT on a table that has an "occurs ... depending on ..."
clause.
A bug during compilation with the OPT(3) directive set, where a loop variable could contain an incorrect
value after a PERFORM UNTIL loop, has been fixed.
An error no longer occurs as the result of using the 'AS template-1' phrase within an INVOKE
statement. Previously, this could generate a COBRT240 runtime error.

•

On little-endian 64-bit platforms, such as Windows 64-bit or Linux x86 64-bit, a bug could occur with the
following code: add 1 to var-a add 1 to var-a giving var-b where var-a is a comp or comp-x item less
than 8 bytes in size. The result of the bug was that the wrong value was stored in var-b. This bug has
been fixed.

•

While debugging using previous versions, an exception occurring in a program using copy files could
lead to the debugger showing an arbitrary position in one of the copy files.

•
•

2825779 (1100297)
A compile time error when compiling to JVM bytecode, and where $CLASSPATH is longer than 4096
characters, has been fixed.
In managed code, a contained class with the SHARING PARENT phrase is now able to access PIC X
and other native COBOL data in the object section of the containing class. Previously, this did not
produce a syntax error but caused the generation of bad code.

•

2851402 (1103200)
An error during compilation on the code generated by Visual Studio when adding a user control to a
WinForm has been fixed.

•

2846867 (1102664)
A named parameter targeting a MicroFocus.COBOL.Program.Reference object no longer causes the
generation of bad code and system errors.

•

2844673 (1102345)
An XML PARSE or XML GENERATE statement with a GO TO in the ON EXCEPTION clause now
compiles as expected for managed code.

•
•

•

•

2844550 (1102309)
The debugger now executes as expected when a WPF application includes a nested class.
2844416 (1102294)
Previously, when a file was declared in the instance data of a class (e.g. within OBJECT/END OBJECT
headers), and the file did not declare a status field, an attempt to add the class to a run unit could fail.
This has been resolved.
2844146 (1102639)
The compiler no longer produces an incorrect error message in cases where a property expression is
used as an argument to an 'old-style' invoke statement. A possible work-around also existed when
receiving the error, which was to replace the old-style syntax: invoke my-object "MethodName" using
(obj::Property1) with the new: invoke my-object::MethodName(obj::Property1).
2843344 (1102232)
When compiling for JVM COBOL with the OUTDD directive, a DISPLAY statement with more than one
operand, or a DISPLAY WITH NO ADVANCING statement no longer causes the generation of illegal
code, and a run-time error when the class is loaded.

•

2842263 (1102086)
The DIVIDE statement with the REMAINDER phrase now gives correct results under
DIALECT"ENTCOBOL".

•

2841964 (1102206)
Errors encountered while attempting to resolve type references are now included in the count of errors
printed at the end of the compilation listing.

•

2841074 (1101923)
Programs using the IBMCOMP directive no longer crash during 64-bit compilation when the program
contains an arithmetic expression (-1 * long-numeric), where long-numeric is declared as pic s9(18)
comp.
2834718 (1101195)
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•

In versions of the product before 2.2, it was permissible to define a level 88 condition on a data item in
the linkage section of an interface method definition. Such level 88 items were simply ignored during the
generation of the code for the interface. In version 2.2.1, this syntax started to produce an error. We
have now reverted to the previous behavior, where these level 88 items are permitted, but ignored.
2833633 (1101111)

Data Tools
Back to the list
•
•
•
•
•

When filtering records, it is based on the selected encoding when the Filter dialog box was opened.
Previously, the filter was only using ANSI encoding.
The editing caret no longer disappears when in Edit mode.
The Hex View is now displayed when you click Toggle Hex after opening a data file that does not
contain a layout.
Deleting the last record in a sequential fixed-block file or a line sequential file no longer produces an
error message or crashes the editor.
When copying and pasting records, the record length for fixed block files is no longer resized.
2833640 (1101732)

Debugging
Back to the list
•

•

The handling of NLS, Japanese and multi-byte character sequences has been improved, when
animating programs on UNIX.
2836278 (1101545)
On Windows, the CBL_DEBUG_START routine will now use the COBANIMSRV environment variable
as the identifier, if the identifier passed in is NULL. This also means that cross-session animation now
works as per the UNIX environment.

Documentation
Back to the list
•

The instructions in the product help on how to run .NET COBOL applications from a network server
have been updated. These now include details about how to make the appropriate .NET run-time
assemblies available to your applications and how to elevate the security permissions levels of the
applications.

•

2826751 (1100478)
Dead Code Analysis is not supported for remote COBOL projects. Clarification of this restriction has
been added to the documentation.

•

2814273 (1098595)
When handling XML files, after a successful WRITE action, the size of the XML file written is returned
as the status code.

•

•

2587541 (1085484)
When using Fileshare with the CCISM protocol, ensure the server is started using the /SC switch. This
switch starts Fileshare in synchronous communications mode, which gives better performance than
when using Fileshare with the CCITCP protocol. Without this switch, Fileshare operations may be
slower.
An Enterprise Server error message has been added to the help pages for CASKC0048, process softkilled failed and was hard-killed.
2846350 (1102574)
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•

The ldpli topics have been updated to include information about native ld options.

•

2840325 (1101829)
The product help now provides the correct definition of the ES_ESM_RESSEC environment variable.
2836105 (1101281)

•

The "mfsupport" utility is now correctly named and spelled as MFSupportInfo, for Windows platforms.

•

2848869 (1102896)
In the topic "Sample Parameters File", the value of Keys towards the end of the code sample has been
changed from 48 to 60.

•
•

•

2844479 (1102300)
The parameter TSOE_JOBPREFIX has been replaced with TSOE_JOBCHAR.
2844210 (1102719)
Additional information added to the help pages for the audit event codes emitted by the External
Security Facility (ESF) and Micro Focus Directory Server (MFDS).
2842807 (1102120)
If you receive a 9/064 file status, this is informing you that a process has attempted to open a file using
a different locking mode than the one that is already in place. The locking mode is determined by the
tunable strict_file_locking. All processes accessing the same file need to be using the same locking
mode; that is, all have the tunable set to the same value, which can be either 'true' or 'false'.
2837405 (1101440)

•

Option D(o) in the Character Animator is only applicable when you are debugging intermediate (.int)
code.
2839572 (1101835)

Editor Writing Assistance
Back to the list
•
•
•

•

•
•
•
•
•
•

IntelliSense (in Visual Studio) and Content Assist (Eclipse) no longer offer verbs within EXEC blocks.
The END-EXEC statement is offered instead.
The IntelliSense suggestions now include the attributes for any reference, output or returning
parameters that are explicitly declared in the linkage section.
An issue where IntelliSense (Visual Studio) and Content Assist (Eclipse) offered Sort/Merge items
where only file items were valid has been resolved.
(616206)
Intellisense (Visual Studio) and Content Assist (Eclipse) now only offer suggestions for types which are
suitable to the context. For example, the suggestions for a CATCH phrase only include exception types
and the suggestions after NEW only include constructable types.
In Visual Studio, IntelliSense is now only triggered when typing characters which are expected to form a
part of a valid COBOL word.
Intellisense (Visual Studio) and Content Assist (Eclipse) now offer members of the current type when
there is no qualification using "SELF::" or "SUPER::".
Intellisense (Visual Studio) and Content Assist (Eclipse) now offer suggestions for READY TRACE and
RESET TRACE.
The Intellisense (Visual Studio) and Content Assist (Eclipse) suggestions no longer include multiple
imported types with the same short names.
IntelliSense (Visual Studio) and Content Assist (Eclipse) now offer suggestions for specifying array
types (OCCURS) in managed COBOL.
IntelliSense (Visual Studio) and Content Assist (Eclipse) now offer all relevant data for EXHIBIT
statements.

Resolved Issues
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•
•
•
•
•
•
•
•
•
•
•
•

IntelliSense (in Visual Studio) and Content Assist (in Eclipse) now correctly handle the automatic import
of the namespace (and any nested types) from the current type.
Sometimes, the IntelliSense suggestions after the SIZE OF phrase did not include the available local
arrays.
IntelliSense now works for #-escaped identifiers.
In Visual Studio, IntelliSense now always inserts member names in the same case as they were
declared regardless of the IDE preferences for the case of data items.
Previously, when a type name was selected in IntelliSense list, the namespace separator dot could
incorrectly get removed.
Condition-value items are now correctly accepted as complete conditional expressions.
IntelliSense (Visual Studio) and Content Assist (Eclipse) no longer offer completion suggestions outside
of their proper scope.
IntelliSense now offers suggestions for method arguments that contain arithmetic expressions.
Overridden generic methods no longer get listed multiple times in the IntelliSense suggestions.
You no longer receive IntelliSense suggestions when you start typing in the middle of a word.
IntelliSense proposals now correctly replace unquoted copybook names in the editor.
In managed COBOL programs without headers, the IntelliSense (Visual Studio) and Content Assist
(Eclipse) lists of proposals now include variables.

Enterprise Server
Back to the list
•

•

•
•

•

•

•

•

The caslock utility now validates the APPLID. In order for caslock to remove all locks for a given cluster
client, the passed APPLID must already be known to the GLM - for example, it must already have an
entry in the CASGLM.LCK file.
2847684 (1103145)
When processing a WSBIND that contain nested occurs levels, the group level is now correctly
maintained.
2844738 (1102697)
XA transactions will now end when an ECI request fails with PGMIDERR.
2843668 (1102276)
The order in which user privileges are checked when accessing cataloged files has changed. First, a
check for the alter privilege is performed. If access is denied, Enterprise Server performs a check for
update privileges. If this check fails as well, a final check for read access is performed. This is reflected
in both the console log output and in any Audit Manager events that are generated.
2842162 (1102048)
Previously, when generating a MQRFH2 header, the CCSID that was used was 0. This resulted in an
abend APIJ on the CPIL transaction and in an error 2111 on the MQGET API. The MQRFH2 header is
now generated with the correct CCSID values.
2841974 (1102004)
When the targetService option was enabled for the JMS Invoke Webservice, no response was returned
to the application if the URIMAP was not found. This caused the transaction to hang. A message is now
sent to the Dead Letter Queue, and the application fails with an error message DFHPI0112.
2841602 (1101959)
casspool type 16 records (spool-printed-88) are now being processed and the printed spool records get
deleted when using Delete from the ESMAC page.
2839657 (1101706)
A Run-Time System error 114 no longer occurs when a GET request is received.
2825851 (1100157)
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•

•
•

You can now start Enterprise Server instances that have the casuesm exit enabled. If you are already
using this exit, you must recompile your applications using the updated cascbesm.cpy that is in the
cpylib subfolder in the product installation directory. You also need to include the version check at
initialization time that is implemented in the skeleton casuesm.cbl file that is in the src in the product
installation directory.
2821228 (1099658)
You no longer receive a memory leak in cassi processes when using the Micro Focus External Call
Interface.
If no license has been found when starting Enterprise Server, Enterprise Server Administration now
periodically checks whether a license server is present.
2836688 (1101388)

•

•

•

The Enterprise Server External Security Facility, using LDAP-based security, no longer incorrectly
matches a wildcard character ("*") in a resource access rule to a period (".") in the requested resource
name. The double wildcard sequence ("**") does match a period (".").
2854402 (1103604)
When using LDAP-based security immediately after installing Enterprise Server, with the sample access
rules provided with the product, the TRANCLASS definitions in ESMAC are now granted administrative
access to as it is for other resource types.
2838380 (1101547)
The LISTREFERENCES command now works correctly when the resource class names use special
characters.

File Handling
Back to the list
•

•

•
•

OPEN EXTEND EXCLUSIVE for sequential files accessed via ACUFH/RMFM now correctly locks the
file.
2849233 (1102953)
If a program opens an RM/COBOL or ACUCOBOL-GT data file, and the file format has been specified
at compile time (and not in a run-time config file), then file assignments containing a sub-path will
correctly search locations specified by COBDATA.
2842825 (1102218)
Rebuild now correctly processes the key structure defined through an options file.
2837028 (1101412)
Relative filenames specified with dot-slash (e.g. ./file.dat) will now match filename tags in the extfh.cfg
configuration file (e.g. [file.dat]).
2832386 (1100932)

•

•

Rebuild option /t now supports extended ESDS (XESDS) files. Rebuild also allows you to create an
ESDS file without supplying the index key information (option /k).
2837756 (615857)
Rebuild now allows the case where "9" is specified after ":"
2836782 (1101437)

IDE
Back to the list
•

When examining the value of object expressions in Visual Studio, the description of the class is now
available and the instance data can be examined.
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•

•

•
•

•
•

•
•
•
•
•
•

•

2841885 (1102449)
By default, pressing Space no longer inserts the highlighted item in the IntelliSense suggestions. You
can change this behavior from the Insertion page in Tools > Options > Text Editor > Micro Focus
COBOL > IntelliSense.
After splitting an editor window, hovering a data item in one of the panes of the editor could cause the
IDE to crash.
Previously, if you had a COBOL program opened in the editor and that program did not belong to any of
the projects in your current solution, using the Start Debugging context menu would not start debugging
the StartUp project of the solution.
Stepping into a debuggable native code program which is not part of a project could cause the Visual
Studio IDE to crash.
When debugging .NET COBOL code, groups that are not referenced might be optimized for
performance by the Compiler. In such cases, when querying groups in the debugger, the length of the
group and the contained group data are not shown in the debugger by default. To ensure you see this
data, you need to compile the code with the NOILOPTIMIZEDATA Compiler directive.
Native COBOL projects that contain programs with names that include non-ASCII characters now build
successfully.
Debugger data tips are now displayed correctly in the expanded copybook view in the editor.
The COBOL editor in Visual Studio now colorizes floating point numeric literals.
HotFix 1 of Visual COBOL 2.3 for Visual Studio 2015 and Enterprise Developer 2.3 for Visual Studio
2015 provides support for version 2.7 of the Azure Tools for Visual Studio.
When creating a new ASP.NET Web Application project, the login page is now displayed correctly.
Debugging of remote application attachments now respects the order of source containers during
source lookup instead of relying on the information in the IDY files.
2845910 (1102501)
Error annotations that follow INCLUDE statements are now displayed on correct lines.

•

2845634 (1102720)
The 'delimited' and 'delimited by size' COBOL program clauses no longer prevents the Outline view and
Content Assist from functioning correctly.

•

2843597 (1102236)
Each project now has its own build console that accumulates build output until explicitly cleared or
closed by the user.

•

2841821 (1102009)
Added new system property build.errors.limit which limits the maximum number of problem error
markers created as part of a build. You can modify this property by editing the eclipse.ini file.

•

2840702 (1101870)
A momentary loss of network connectivity can result in COBOL Project settings being lost if the project
was stored on a network location.

•

2833101 (1101082)
When debugging native COBOL applications the .idy file loaded by the debugger is now used to create
the editor's Outline view and other information such as content assist and colourization.

•
•
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2842968 (1102127)
Hovering the mouse over a data item in the Code Definition window in Visual Studio could result in
receiving an exception.
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2827035 (1101229)
A full rebuild of all projects in a workspace could sometimes be triggered after restarting Eclipse.
2816310 (1101363)
Debugging network file system remote projects can be made faster by using the 'Remote File System
Directory' container to specify the source lookup path on the Source tab of the Debug launch
configuration.

•

2792882 (1096491)
By selecting the "Create top-level folder" option when importing the copybooks and then adding the
folder to the Dependency Paths/Copybooks, the project will compile successfully.

•

2682665 (1092789)
It is now possible to change the compiler directives in the project settings without cleaning the build
artifacts through the use of a new preference.
2647695 (1089794)

Integrated Preprocessor
Back to the list
•

•

Programs with EXEC SQL INCLUDE statements that have a trailing period that is not immediately
following the END-EXEC now compile as expected with the COBSQL preprocessor.
2844222 (1102486)
A user preprocessor which calls directly the 'CP' system preprocessor now behaves as expected during
the syntax checking of source files you are editing.

Interface Mapping Toolkit
Back to the list
•
•

Ebiz execution no longer fails when tracing is enabled and several programs contain a mismatched
linkage offset.
JSON request messages containing multi-byte UTF8 characters caused errors for REST web services.

Micro Focus Common Client
Back to the list
•

COBOL Web, EJB, and REST services with Japanese characters in their names can now be deployed
to Enterprise Server.

Micro Focus Directory Server
Back to the list
•

Fixed an issue in the Enterprise Developer Administration HTML GUI if a long user id value was input.

•

2846804 (1102971)
Enterprise Server instance startup performance has been improved, particularly when the Enterprise
Server Administration GUI has been configured to use SSL.

•

2837359 (1101501)
Issue fixed where the Enterprise Server Administration HTML GUI occasionally became unresponsive if
configured to use an SSL browser connection.

•

2834446 (1101342)
The Enterprise Server user id no longer needs to have security administration access permissions to
start an Enterprise Server instance if external security is specified.

Monitoring and Management
Back to the list
•

The Operations Manager agent no longer logs a warning event 21405 for machines being monitored
that do not have Enterprise Server installed .
2830110 (1100895)
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Run-Time System
Back to the list
•

In the JVM COBOL run time, an alphanumeric comparison with a collating sequence now gives correct
results for character values greater than 127.
2839717 (1101845)

•

•

•

•
•
•

If a file is opened for Read with 'deny neither read nor write' and then the same file is opened for Read
(or Read/Write) with 'deny write', then when the second FD is closed, the 'deny write' file lock was NOT
removed. This has now been resolved.
2837230 (1101419)
64-bit Windows only, and native generated code only. Programs containing code of the form 01 f
comp-2. compute f = f ** 0.5 no longer give a load error at run time (for .gnt code) or fail to link (.obj
code) with the message "unresolved external symbol _tMc4506".
2836893 (1101465)
When using "mfauditadm -r" on an audit file containing processes that have very long command lines,
the process could terminate early with a memory fault. This has now been resolved.
2832770 (1101000)
The Sharedmem demo has been updated to make it compatible across all supported UNIX platforms.
Previously, on some platforms the semaphore synchronization did not work.
Repeatedly calling and cancelling different programs in different threads could cause the application to
hang. This has now been resolved.
In the .NET runtime, a managed executable can now be successfully executed using
CBL_EXEC_RUN_UNIT when an explicit .exe extension is specified in the program name.

•

2845604 (1102669)
A new library routine, PC_PRINTER_INFO_DOTNET, is now available for .NET COBOL applications. It
enables the access to the .NET Graphics/PageSettings objects.

•

2845991 (1102545)
.NET COBOL applications can now use PC_PRINTER_LOAD_BMP more than once without this
causing unexpected exceptions.

•

2845991 (1102546)
Applications that use run units created with the MicroFocus.COBOL.RuntimeServices class could leak
memory.

•

2838583 (1101639)
The XML I-O preprocessor no longer incorrectly represents some fixed point values in floating point
format.
2837561 (1101473)

SQL: COBSQL
Back to the list
•

The COBSQL preprocessor has been updated to correctly handle P(CP) with the NOSQL directive.

•

2850394 (1103086)
Background parse should now create temporary files with names that differ from the actual build
process.
2843719 (1102613)

DB2
Back to the list
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•

•

A compiler error that resulted from the DB2 ECM preprocessor incorrectly handling embedded
comments within an SQL statement has been fixed.
2846756 (1102646)
An HCO pre-compiler routine incorrectly replaced an underscore in host variable name which resulted
in invalid host variable. This has now been fixed.
2837674 (1101487)

SQL: OpenESQL
Back to the list
•

An overflow problem with host variables of type System.Decimal has been fixed.

•

2849939 (1103195)
OpenESQL has been updated to correctly handle cursors in static methods when using DBMAN=ODBC
in a managed application.

•
•

•

2847268 (1102968)
A problem with EXEC ADO REBIND CONNECTION has been fixed.
2846426 (1102645)
In some scenarios, OpenESQL for ADO.NET incorrectly handled level 49 VARCHAR host variables
defined with zero (0) length.
2845409 (1102510)
HCOSS with SQL(CHECKCALLPARAMS) now correctly determines parameter types and directions for
SQL, SQL synonym, and SQL CLR stored procedure calls that use four-part names, and that are
located on other servers or in other databases.

•

2844292 (1102483)
HCOSS did not fully support DB2 ROW_NUMBER().

•

2843937 (1102362)
Using SQL(CHECK) with .NET applications caused an error on Oracle.

•

2842102 (1102037)
The OpenESQL JVM Runtime was updated to correctly process a FETCH from a VARCHAR column
where the field is zero length.

•

2841149 (1102637)
The Project Properties user interface has been updated to include SYBASE and INFORMIX-NEW on
the COBSQLTYPE options list.

•

2840953 (1101877)
An EXEC ADO GET DATATABLE statement for DataTables contained within a dataset resulted in SQL
errors.

•

2837717 (1101484)
HCO for SQL Server incorrectly returned result set locators for result sets containing VARCHAR(MAX)
columns.

•

2832384 (1101169)
The ADO and JDBC runtimes have been updated to fix a share lock problem that occurred when
SQL(ISOLATION) was set.
2797208 (1096456)

•

To correct a problem when using SQL(DETECTDATE) with SQL Server datetime columns, applications
updating to Visual COBOL 2.3 might require use of the SQL(DETECTDATE) directive if they use SQL
Server datetime columns with PIC X host variables. Alternative solutions are to switch to datetime2, or
to use SQL TYPE TIMESTAMP host variables.
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•

•

•

•

•

2848402 (1102838)
When using SQL Server version 2012 SP2 or later, OpenESQL now supports a [NOCHECK] statement
prefix to enable SQL(CHECK) to be disabled on a per-statement basis. If used with other statement
prefixes, it must come first. When compiling programs that use global temporary tables, HCOSS
executes converted DECLARE GLOBAL TEMPORARY statements at compile time. These enable
subsequent statements that reference the temporary table to be checked using SQL(CHECK).
2847791 (1102782)
OpenESQL now supports SQL(DETECTDATE=SERVER) when using the ADO.NET runtime and SQL
Server version 2012 or later. SQL(DETECTDATE=SERVER) is ignored when using ADO.NET with
earlier versions of SQL Server, and when using any other database.
2846825 (1102701)
When migrating a DB2 application using HCOSS, a compiler error caused by string concatenations that
included literals containing angle bracket characters has been corrected.
2846226 (1102582)
A new directive, CHECKSP, has been added to the OpenESQL preprocessor to verify whether or not
parameters match the COBOL definitions defined in a stored procedure. If not, the OpenESQL
preprocessor generates error ES0127. The syntax is: SQL(CHECKSP=<spd-filename> CHECKSP
applies only when SQL(SPCALLLOCAL) is also used.

•

2844399 (1102329)
The POSTGRESQL parameter for the TARGETDB SQL compiler directive option was erroneously
omitted from the drop-down list in the user interface.

•

2842879 (1102128)
When using the OpenESQL JDBC Managed Runtime with positioned updates on a cursor, an error
occurred when the same cursor was opened and closed multiple times.

•

2841857 (1102003)
The OpenESQL runtime for ADO.NET was erroneously trimming trailing spaces from variable-length
input host variables that used an explicit-length field.

•

2841721 (1102106)
A problem with disconnecting named connections when using the JDBC runtime for OpenESQL has
been fixed.

•

2841508 (616495)
When compiling applications with SQL(DIALECT=MAINFRAME), literals could be corrupted with
embedded spaces.

•

2839826 (1101752)
In European locales, Oracle queries failed to return the decimal symbol for floating point results
returned to decimal numeric host variables.

•

30

2850022 (1103058)
To correct a problem with closing CURSORs, SQL(SPCALLLOCAL) can now be used to instruct
OpenESQL to detect and close cursors associated with simulated stored procedures not closed by an
application.

2839066 (1102162)
OpenESQL SAVEPOINT handling was not working as expected with Static SQL.

•

2838227 (1101571)
An HCOSS stored procedure called from multiple locations in either the calling application or in a
nested stored procedure, and that returns result set locators, resulted in an SQLCODE error.

•

2834386 (1101104)
HCO for SQL Server returned incorrect output parameter values when a CALL statement specified a
stored procedure name in a host variable.

| Resolved Issues

•

•
•

•

•
•

2833755 (1101022)
OpenESQL with DATE+EUR erroneously returned values representing a 12-hour clock. Returned
values now correctly represent a 24-hour clock.
2833683 (1101017)
The SPD Generator did not set the NOTRUNC directive when generating a SQL CLR wrapper.
2829499 (1102075)
When running in ODBC mode, the OpenESQL Assistant DCLGEN sometimes generated incorrect
TIMESTAMP and DATE column sizes. It now generates the TIMESTAMP(6) columns as PIC X(26) and
the DATE columns either as PIC X(19) or X(10) based on the NLS_DATE_FORMAT setting.
2823577 (1099922)
The documentation has been updated to clarify the issue of trailing spaces in comparisons for PIC X
host variables with CHAR and VARCHAR columns.
2806980 (1097582)
An attempt to compile in Visual COBOL with OpenESQL using unsupported HCOSS directives now
returns errors rather than warnings. HCOSS is not supported in Visual COBOL.
OpenESQL for ADO.NET did not recognize and handle Oracle's full managed .NET provider in addition
to the original partially managed provider. Note: The two providers are not 100% compatible. The
partially managed provider uses NLS settings for date/time formatting and the fully managed provider
uses the local machine locale.

SQL Option for DB2
Back to the list
•

The XDB pre-processor incorrectly processed SQL statement that had embedded singles within a
literal. This resulted in receiving an incorrect message "cobsql0111e - no from clause specified error".
2850293 (1103073)

•

When using an open cursor with constants comparison in an IN () clause, an Sqlcode -1352 error
occurred.

•

2844111 (1102266)
An SQL statement with SELECT caused an XDB with Server Violation error when converting from the
CHARACTER to INTEGER type in the INSERT SQL statement.

•

2839382 (1101677)
Incorrect results sometimes occurred when using a host variable for the second parameter of the SQL
scalar function ROUND() function.
2831359 (1101083)

•

Exiting SQLWizard processing no longer causes an exception.

•

2849696 (1103097)
A problem with the display of code page conversions in the SQLWizard Import/Export dialog boxes has
been resolved.

•
•

2846196 (1102659)
An issue that resulted in a syntax error when editing tables with decimal data has been resolved.
2840937 (1101960)
Exporting a table with a reserved word as a column name no longer produces an error X020 if the
quoting types are Apost or Quote.
2806803 (1097559)

•

An RTS 114 error would sometimes occur on an UPDATE WHERE CURRENT OF CURSOR.
2840936 (1101868)

Resolved Issues

| 31

•

•

When executing a batch job containing XDB Null loads, an error occurred during DSNUTILB processing
when loading the XICU40N DLL.
2840147 (1101785)
An execution error resulted when using dynamic SQL with an SQLDA SQLN integer much larger than
required for input parameter markers.
2818992 (1099256)

XML Support
Back to the list
•

PREXML now terminates and returns an error message if there is a problem expanding a copybook.

•

2472213 (1076394)
XMLPARSE did not honor the encoding in the XML declaration for output text.

•

•

2851343 (1103239)
XML WRITE with CHECK VALIDITY OUTPUT no longer causes RTS 114 error if the written document
contains an XML declaration.
2837110 (1101424)
XMLPARSE did not handle CONTENT-CHARACTERS correctly in XMLSS mode.
2822339 (1099692)
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Other Issues Resolved in This Release
The numbers listed are the Support Incident Numbers followed by the Reported Problem Incident (RPI)
number (in parentheses).
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

2266906 (1066314)
2541594 (1081441)
2610077 (1087571)
2613606 (1088533)
2691674 (1093498)
2784725 (1095083)
2792882 (1102055)
2801626 (1097006)
2801847 (1097374)
2805056 (1097357)
2806566 (1097816)
2807649 (1097763)
2809132 (1097892)
2812331 (1098359)
2815582 (1099634)
2817630 (1101066)
2824712 (1100086)
2824925 (1099961)
2825098 (1100032)
2825249 (1101374)
2827707 (1100302)
2828305 (1100419)
2828897 (1100491)
2829677 (1100588)
2830741 (1100655)
2830871 (1100785)
2831477 (1100831)
2831788 (1100810)
2831959 (1100864)
2832490 (1100907)
2832904 (1100916)
2833083 (1101060)
2833100 (1101123)

•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

2833473 (1101007)
2833925 (1101045)
2834217 (1101124)
2834245 (1101085)
2834253 (1101099)
2834843 (1101156)
2834959 (1101167)
2835289 (1101498)
2835416 (1101496)
2835506 (1101288)
2835508 (1101292)
2835599 (1101293)
2835608 (1101494)
2835687 (1101497)
2835835 (1101262)
2836694 (1101356)
2837531 (1101490)
2837784 (1101511)
2838086 (1101525)
2838343 (1101586)
2838426 (1101552)
2838593 (1101986)
2838671 (1101587)
2838689 (1102052)
2839730 (1101776)
2840155 (1101821)
2840349 (1101906)
2840530 (1101860)
2840658 (1101893)
2840766 (1101857)
2840977 (1102019)
2841607 (1101961)
2841785 (1101988)

•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

2841933 (1102021)
2842318 (1102129)
2842702 (1102121)
2842940 (1102122)
2843048 (1102186)
2843076 (1102135)
2843140 (1102509)
2843301 (1102185)
2843324 (1102296)
2843438 (1102240)
2843446 (1102173)
2843446 (1102174)
2843884 (1102492)
2845184 (1102627)
2845218 (1102490)
2845635 (1102601)
2845781 (1102730)
2846150 (1102557)
2846669 (1102644)
2846797 (1102780)
2846971 (1103070)
2847253 (1102806)
2847876 (1102765)
2848324 (1103143)
2849271 (1103044)
2849307 (1102974)
2849430 (1103011)
2849508 (1102970)
2849972 (1103094)
2851114 (1103175)
2851169 (1103174)
2852143 (1103362)
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Installation
Before Installing
Downloading the Product
You can download Visual COBOL from the Product Updates section of the Micro Focus SupportLine Web
site.

System Requirements
System Requirements for Visual COBOL for Visual Studio
Hardware Requirements
Visual COBOL has the following requirements in addition to the requirements of Microsoft Visual Studio.
See the Visual Studio documentation for details of the Microsoft requirements.
The maximum disk space requirements are, approximately:
Visual COBOL

Sentinel RMS License Manager

1.2Gb

75MB

•
•

This includes the space needed to cache information locally so that you can modify the installation
without the original source media.
The disk space requirements include the versions of JRE and .NET Framework supplied with the setup
file.

Operating Systems Supported
For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.
Note:
•

You can produce both 32-bit or 64-bit applications with Visual COBOL installed on a 64-bit
operating system.

•
•

Visual COBOL for Visual Studio is not supported on versions of Windows earlier than Windows 7.
The Enterprise Server feature is not supported on Windows XP.

Software Requirements
The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components.
Note:
•
•
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Besides the software listed below, the setup file also installs the 32-bit Java 8 Update 51.
This product includes OpenSSL version 1.0.1p.

Visual Studio IDE
This product requires Microsoft's Visual Studio.
You need one of the advanced versions of Visual Studio listed below or the Visual Studio Integrated Shell
(only supported by Visual COBOL for Visual Studio 2012 or 2013):
Professional, Premium, or Ultimate (for Visual Studio 2012)
Professional, Premium, Ultimate or Community Edition (for Visual Studio 2013)
Professional, Enterprise or Community Edition (for Visual Studio 2015)
Microsoft's Visual Studio Express Edition is not supported.
If there is no Visual Studio installed on your machine, the setup file for Visual COBOL for Visual Studio
2012 or 2013 will install the Visual Studio Integrated Shell. Alternatively, you can download the Visual
Studio Integrated Shell from the Microsoft Download Center and install it before you install Visual COBOL.
If you choose to install the Shell, ensure you run the installer to complete the installation - run
vsintshell.enu.exe from the location where you installed the download.
Note that some Visual Studio features might not be available with the Shell. This includes WCF or the
Visual Studio 2013 Connected IDE experience in the Visual Studio 2013 Shell - the help for more details.
Important:
•

A problem with Microsoft's Windows 10 prevents installing the Visual Studio 2013 Shell on that
version of the OS. You must install an advanced edition of Visual Studio 2013 on Windows 10
before you start the installation of Visual COBOL for Visual Studio 2013.

•

Visual COBOL for Visual Studio 2015 does not support Visual Studio 2015 Shell as the Shell has a
number of restrictions to COBOL development. The Visual Studio 2015 Shell is not included in the
setup for Visual COBOL for Visual Studio 2015 and before you start the installation, ensure that
there is an advanced edition of Visual Studio 2015 installed on your machine.
On Windows 8.1 RT, Windows 8.1 or Windows Server 2012 R2, you must have the Windows
update KB 2919355 before you install Visual Studio 2015. Download KB 2919355 from the
Microsoft Download Center.

•

•

Code generation issues in Microsoft's 64-bit JIT (just-in-time) compiler delivered as part of .NET
Framework version 4.6 can result in incorrect execution of some COBOL code compiled to .NET.
Version 4.6 of the .NET Framework is currently shipped as default with Visual Studio 2015 and
Microsoft's Windows 10. The problems include incorrect execution of MOVE and STRING
statements applied to alphanumeric operands, and incorrect execution of the ROUNDED phrase
for arithmetic statements.
Some of these issues only seem to be reproducible in COBOL language applications compiled
to .NET and some can be reproduced in other languages (C# or Visual Basic).
These problems have been reported and acknowledged by Microsoft and it is our belief that they
either have resolutions or are working on fixes for all of them. For further information about these
issues and guidelines on how to disable the latest version of the 64-bit JIT compiler, see RyuJIT
Bug Advisory and Troubleshooting RyuJIT.
As of October 2015, Microsoft have released the following updates that address these issues with
the .NET Framework 4.6:
•
•
•

Hotfix rollup 3088955 for the .NET Framework 4.6 on Windows Server 2012 and Windows 8 see: http://www.microfocus.com/docs/links.asp?vc=mskb3088955.
Hotfix rollup 3088956 for the .NET Framework 4.6 on Windows Server 2012 R2 and Windows
8.1 - see: http://www.microfocus.com/docs/links.asp?vc=mskb3088956
Hotfix rollup 3088957 for the .NET Framework 4.6 on Windows 7 SP1, Windows Server 2008
SP2, Windows Server 2008 R2 SP1, and Windows Vista SP2 - see: http://
www.microfocus.com/docs/links.asp?vc=mskb3088957.
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•

Cumulative update 3093266 for Windows 10: September 30, 2015 (available through Windows
Update) - see: http://www.microfocus.com/docs/links.asp?vc=mskb3093266.

The following software is also required:
•
•
•
•

Microsoft Windows SDK is required if you are using the Visual Studio Shell. See the Microsoft
Download Center and search for Windows SDK.
Microsoft .NET Framework 4.5. This is included with Visual Studio 2012.
Microsoft .NET Framework 4.5.1. This is included with Visual Studio 2013.
Microsoft .NET Framework 4.6. This is included with Visual Studio 2015.

Internet Explorer 10
Internet Explorer 10 (IE 10) is required by the installation of Visual Studio 2013. If you are installing Visual
COBOL on a machine that has no Visual Studio 2013 installed, the setup file installs Visual Studio 2013
Shell provided that IE 10 is installed beforehand. You can download IE 10 from Microsoft's Web site.
IIS Express
IIS Express is required if you want to use the Web development tools. You can download IIS Express from
the Microsoft Download Center.
Other Requirements
Important: This release requires version 10000.2.990 or later of the Micro Focus License
Administration tool. For local servers, you do not need to install it separately, as the setup file installs
a new Visual COBOL client and a new licensing server on the same machine.
If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.
You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

System Requirements for Visual COBOL for Eclipse (Windows)
Hardware Requirements
Visual COBOL has the following requirements in addition to the requirements of Eclipse. See the Eclipse
documentation for details of its requirements.
The disk space requirements are, approximately:
Visual COBOL

Sentinel RMS License Manager

3.7GB

75MB

Note: The disk space requirements include the size of the Eclipse IDE and the version of Java and
the .NET Framework provided with the Visual COBOL setup file. This includes the space needed to
cache information locally so that you can modify the installation without the original source media.
Operating Systems Supported
For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.
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Note:
•
•

Visual COBOL enables you to produce both 64-bit and 32-bit applications on 64-bit operating
systems.
The Enterprise Server feature is not supported on Windows XP.

Software requirements
Note: This product includes OpenSSL version 1.0.1p.
The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components.
Eclipse requirements
•

The setup file installs Visual COBOL and Eclipse 4.4.2.

•

See Installing Visual COBOL into other instances of Eclipse for instructions on how to install Visual
COBOL into other instances of Eclipse installed on your machine.
Visual COBOL does not support the 64-bit Eclipse. You can, however, use the 32-bit Eclipse to create
both 32-bit and 64-bit applications.
Visual COBOL requires a 32-bit Java installation.

•

Software requirements
•

•

Oracle's Java Platform, Enterprise Edition (Java EE) Java 7 or Java 8 is required to execute COBOL
JVM code and for native COBOL and Java interoperability. You can download Oracle's Java EE from
Oracle's web site and install it anywhere on your machine.
Note: If Java 7 is installed on your machine, to skip installing Java 8, run the Setup file with the
skipjre=1 command line option.
The setup file also installs .NET Framework v4.5.2 and the Microsoft Visual C++ 2010 and 2012
Redistributables.

See the Java Support Considerations for the Eclipse IDE in the Known Issues and Restrictions section in
your product help for considerations that apply to using the Eclipse IDE and Java.
Important: This release requires version 10000.2.990 or later of the Micro Focus License
Administration tool. For local servers, you do not need to install it separately, as the setup file installs
a new Visual COBOL client and a new licensing server on the same machine.
If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.
You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

System Requirements for Visual COBOL for Eclipse (UNIX)
Hardware Requirements for Visual COBOL for Eclipse
Visual COBOL has the following requirements in addition to the requirements of Eclipse. See the Eclipse
documentation for details of its requirements.
The disk space requirements are approximately:
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Platform

Installer type

Setup

Disk space

Disk space

Sentinel RMS

file size

required for

required for

(MB)

the installation

running

license
server

(GB)

the product

(MB)

(GB)
x86-64
running Red
Hat Linux

Micro Focus installer

923

3.69

1.84

46

x86-64
Micro Focus installer
running SUSE
SLES

927

3.71

1.85

46

Operating Systems Supported
Note: You can produce both 64-bit and 32-bit applications on 64-bit operating systems.
For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.
Software Requirements
Eclipse requirements
•
•
•

Visual COBOL only supports the 32-bit Eclipse IDE and requires a 32-bit Java installation.
Visual COBOL does not support the 64-bit Eclipse. You can, however, use the 32-bit Eclipse to create
both 32-bit and 64-bit applications.
The setup file installs Visual COBOL and Eclipse 4.4.2. After the installation, you can install the Visual
COBOL plug-in into other instances of Eclipse available on the same machine. The supported versions
are 4.2 and 4.3 for the 32-bit Eclipse only. See Installing Visual COBOL into other instances of Eclipse
for instructions.

Other software requirements
Before installing this product, you must have the following software installed on your computer:
•

The unzip utility is required by the setup file.

•

The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems
but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax -version at the command line.
The following libraries must be installed:

•

Library
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Platform
SUSE 11

SUSE 12

glibc-locale-32bit

X

X

gcc

X

X

gtk2 (libgtk2, gtk2tools-32-bit)

X

libXcomposite1-32
bit

X

Red Hat 6.x

Red Hat 7

Library

Platform
SUSE 11

SUSE 12

Red Hat 6.x

Red Hat 7

gcc*.i686

X

X

glibc-*.x86_64

X

X

glibc-*.i686

X

X

libgcc-*.x86_64

X

X

libgcc-*.i686

X

X

libstdc++-*.x86_64

X

X

libstdc++-*.i686

X

X

gtk2-*.x86_64

X

X

gtk2-*.i686

X

X

gtk2engines.*.i686

X

gtk2engines.*.s390

X

gtk2engines.*.x86_64

X

X

libXtst-*.x86_64

X

X

libXtst-*.i686

X

X

libcanberra-gtk2*.x86_64

X

X

libcanberra-gtk2*.i686

X

X

libgnome.x86_64

X

X

libgnome.i686

X

X

PackageKit-gtkmodule-*.x86_64

X

X

PackageKit-gtkmodule-*.i686

X

PackageKit-gtkmodule-*.s390

X

libgdk_pixbuf-2_00-32bit

X

gdk-pixbuf-queryloaders-32bit

X

libjasper1-32bit

X

gtk2-x11
(libgthread-2_0-032bit)

X

libXtst6-32bit

X
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Library

Platform
SUSE 11

SUSE 12

Red Hat 6.x

Red Hat 7

PackageKit-gtk3module-*.i686

X

PackageKit-gtk3module-*.s390

X

webkitgtk.x86_64

X

webkitgtk.i686

X

webkitgtk3.x86_64

X

webkitgtk3.i686

X

xterm (any
version)
gdb*

X

X

X

X

X

X

* Additional libraries required to use the core_on_error runtime variable. The gdb packages (for the
GNU Project Debugger) can be installed from the install media for your OS.
** Operating system libraries required for PL/I support on both SUSE and Red Hat.
Visit the Red Hat Web site for more information.
•

Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
installed by default. Use your UNIX/Linux installation media to install it.

•

Oracle's Java Platform, Enterprise Edition (Java EE) 7 or Java 8 is required to run the Eclipse IDE, to
execute COBOL JVM code and for native COBOL and Java interoperability. The setup file installs Java
8 u51 32-bit. You can download Oracle's Java EE from Oracle's Web site and install it anywhere on your
machine.
Note: On Linux, the 32-bit version of Java is required to install and use Visual COBOL for Eclipse.
When you start the installation, if the 64-bit version of Java is already installed on your Linux
machine, you might not be able to install Visual COBOL. This is a known issue with the Oracle
Java installers for Linux which prevent you from installing both the 32-bit and the 64-bit versions of
Java on the same machine. To work around this problem:
•
•
•

Download the 32-bit Java distribution in a compressed .tar format from the Oracle Web site.
Untar the distribution into a location different from the one used for the 64-bit Java version. For
example, untar in /usr/local/java32 and not in /usr/local/java.
Set JAVA_HOME and LD_LIBRARY_PATH to the 32-bit version of Java so that it is used to
install and run Visual COBOL.

Before you start the installation, you need to set the environment as follows:
•

•
•
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You need to set the JAVA_HOME environment variable. When installing the product, set this variable to
a 32-bit Java installation or the installation terminates. For example, execute the following:
JAVA_HOME=java_install_dir
where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
You need to add $JAVA_HOME/bin to your system PATH variable. To do this, execute:
export PATH=$JAVA_HOME/bin:$PATH
You need to set the LANG environment variable to pick up localized messages. The LANG settings are
English and Japanese only.

Important: This release requires version 10000.2.990 or later of the Micro Focus License
Administration tool. For local servers, you do not need to install it separately, as the setup file installs
a new Visual COBOL client and a new licensing server on the same machine.
If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.
You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

System Requirements for Micro Focus Visual COBOL Development
Hub
Hardware Requirements
The disk space requirements are approximately:
Platform

Installer type

Setup

Disk space

Disk space

Sentinel RMS

file size

required for

required for

(MB)

the installation

running

license
server

the product

(MB)

(MB)
POWER
running AIX

Micro Focus

419

1.68 GB

838

36.5

HP IA

Micro Focus

763

3.05 GB

1526

69

346

1.38 GB

692

36

359

1.44 GB

718

46

405

1.62 GB

810

40

375

1.60 GB

750

31

System Z
Micro Focus
running SUSE
installer
SLES

349

1.40 GB

698

36

x86-64
Micro Focus
running SUSE
installer
SLES

364

1.46 GB

728

46

installer

installer
System Z
running Red
Hat Linux

Micro Focus

x86-64
running Red
Hat Linux

Micro Focus

SPARC
running
Solaris

Micro Focus

x86-64
running
Solaris

Micro Focus

installer

installer

installer

installer

Operating Systems Supported
For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.
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Software Requirements
Note: This product includes OpenSSL version 1.0.1p.
Before installing this product, you must have the following software installed on your computer:
•

Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
installed by default. Use your UNIX/Linux installation media to install it.

•

The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems
but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax -version at the command line.
The following operating system libraries must be installed:

•

Library

Platform
SUSE 11

Red Hat 6.x

Red Hat 7

gcc*.i686

X

X

glibc-*.x86_64

X

X

glibc-*.i686

X

X

libgcc-*.x86_64

X

X

libgcc-*.i686

X

X

libstdc++-*.x86_64

X

X

gcc*.s390

X

X

glibc-*.s390

X

X

glibc-*.s390x

X

X

glibc-devel-*.x86_64

X

X

glibc-devel-*.i686

X

X

glibc-devel-*.s390

X

X

glibc-devel-*.s390x

X

X

libstdc++-*.i686

X

X

X

X

glibc-locale-32bit

X

gcc (gcc-32-bit)

X

gdb*

X

•

Visit the Red Hat Web site for more information.

•

Oracle's Java Platform, Enterprise Edition (Java EE) Java 7 or Java 8 is required to execute COBOL
JVM code and for native COBOL and Java interoperability. You can download Oracle's Java EE from
Oracle's web site and install it anywhere on your machine.
Note:
•
•

On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK
is 7.0 Service Refresh 8. You can get IBM's AIX JDK from IBM's Web site.
On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX is JDK
7.0.11. You can get the HP-UX Java JDK from HP's Web site.

To execute COBOL JVM code, you need to set the environment as follows:
•

You need to set the JAVA_HOME environment variable. When installing the product, set this variable to
a 32-bit Java installation or the installation terminates. For example, execute the following:
JAVA_HOME=java_install_dir
where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
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•

You need to add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

•

export PATH=$JAVA_HOME/bin:$PATH
You need to set the LANG environment variable to pick up localized messages. The LANG settings are
English and Japanese only.
Important: This release requires version 10000.2.990 or later of the Micro Focus License
Administration tool. For local servers, you do not need to install it separately, as the setup file installs
a new Visual COBOL client and a new licensing server on the same machine.
If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.
You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

UNIX and Linux Installer Issues
Installing on Linux
On Linux, the 32-bit version of Java is required to install and use Visual COBOL for Eclipse. When you start
the installation, if the 64-bit version of Java is already installed on your Linux machine, you might not be
able to install Visual COBOL. This is a known issue with the Oracle Java installers for Linux which prevent
you from installing both the 32-bit and the 64-bit versions of Java on the same machine. To work around
this problem:
•
•
•

Download the 32-bit Java distribution in a compressed .tar format from the Oracle Web site.
Untar the distribution into a location different from the one used for the 64-bit Java version. For example,
untar in /usr/local/java32 and not in /usr/local/java.
Set JAVA_HOME and LD_LIBRARY_PATH to the 32-bit version of Java so that it is used to install and
run Visual COBOL.

License Server
You need to configure the computer hostname to ensure the license server will start properly.
To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.
The following is an example of how to specify these entries correctly in the etc/hosts file:
127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname
where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Product Co-Existence
Note: The following applies to Windows only.
•
•

Visual COBOL and COBOL Server cannot coexist on the same machine.
Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE
(Visual Studio or Eclipse) you install.
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Basic Installation
The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.
For considerations when installing this product as an upgrade, for additional installation options or nondefault installations, see Advanced Installation Tasks.

Installing Visual COBOL for Visual Studio
Note:
To install this product:
1. Run the vcvs2010_22.exe (or vcvs2012_22.exe when installing the product for Visual Studio
2012) file and follow the wizard instructions to install the prerequisite software and the product.
Note:
•

•

•
•
•

When the installation has completed, on some editions of Windows you might receive a notification
that Visual Studio 2012 has compatibility issues. This is a known Microsoft issue. To resolve it,
follow the instructions in the notification for obtaining help online, or download the KB2781514
update for Visual Studio 2012 from the Microsoft Download Center.
If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Administration. By doing this you maintain the existing Sentinel RMS license files while
adding the Micro Focus License Administration. If you are unsure about existing licenses on your
computer or removing the Sentinel RMS License Manager, consult your System Administrator. If
you want to proceed, remove Sentinel RMS License Manager by using Program and Features
(Windows Vista or later), and rerun the installation file.
Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.
We recommend that you install any updates for Visual Studio and the .NET Framework that are
available at the Microsoft Download site.
If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with Visual COBOL but you can install it if you wish.

Installing on Windows
Note:
•
•

This version of the product is a full install.
If you have an earlier version of Visual COBOL installed on your machine, check Installing as an
Upgrade before you start the installation - see Advanced Installation Tasks.

These are the steps to install Visual COBOL:
1. Run the vce_231.exe file and follow the wizard instructions to complete the installation.
By default, this installs Visual COBOL in the %ProgramFiles(x86)%\Micro Focus\Visual
COBOL folder and installs a full version of Eclipse 4.4.2, with the Micro Focus plugins already installed,
in the C:\Users\Public\Micro Focus\Product Name\eclipse directory.
The setup file installs any missing prerequisite software as listed in the topic Software Requirements.
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Note: See Advanced Installation Tasks for information about non-default installation tasks. For
example, if you have Java 7 installed on your machine and you want to skip installing Java 8, run the
setup file from the command line with the skipjre=1 command line option.

Installing the software
Note: Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus
installer for installing Visual COBOL on UNIX and Linux and a standard RPM (RPM Package
Manager) installer for installing Visual COBOL on Linux. See your product Help for instructions on
how to use the RPM installer.
These are the steps to install this product using the Micro Focus installer:
1. Give execute permissions to the setup file:
chmod +x setup_visualcobol_deveclipse_2.3_update1_platform
2. Run the setup file with superuser permissions:
./setup_visualcobol_deveclipse_2.3_update1_platform
If you don't run this as superuser, you are prompted to enter the superuser password during the install.
The COBOL environment is installed by default into /opt/microfocus/VisualCOBOL, (COBDIR). A
full version of Eclipse, with the Micro Focus plugins already installed, is present in the $COBDIR/
eclipse directory.
To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:
./setup_visualcobol_deveclipse_2.3_update1_platform -installlocation="full
path of new location"
Note: You can use variables or the tilde syntax for the path for –installlocation. For example,
the following examples are equivalent:
-installlocation="/home/myid/installdir"
-installlocation="~myid/installdir"
-installlocation="~/installdir"
-installlocation="$HOME/installdir"
You can see details about which additional parameters can be passed to the install script if you enter
the -help option.
Note:
•

•

The installation of this product could affect the SafeNet Sentinel licensed components running
on your machine. During installation licensing is shutdown to allow files to be updated. To
ensure the processes running on your machine are not affected, you need to use the skipsafenet option, which skips the installation of SafeNet:
. /setup_visualcobol_deveclipse_2.3_update1_platform -skipsafenet
To protect the SafeNet Sentinel installation from accidental updating you can create an empty
file named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:
touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL
While the file is present, the SafeNet installer does not make changes to the installation or
shutdown the running license daemons. If licensing needs to be updated later, remove the file
and install Sentinel RMS server manually.
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Installing Micro Focus Visual COBOL Development
Hub
Note: Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus
installer for installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for
installing on Linux. See your product Help for instructions on how to use the RPM installer.
These are the steps to install this product using the Micro Focus installer:
1. Give execute permissions to the setup file:
chmod +x setup_visualcobol_devhub_2.3_update1_platform
2. Run the installer with superuser permissions:
./setup_visualcobol_devhub_2.3_update1_platform
If you don't run this as superuser you will be prompted to enter the superuser password during the
installation.
The COBOL environment is installed by default into /opt/microfocus/VisualCOBOL, (COBDIR).
SafeNet Sentinel considerations
•

•

The installation of this product could affect the SafeNet Sentinel licensed components running on your
machine. During installation licensing is shutdown to allow files to be updated. To ensure the processes
running on your machine are not affected, you need to use the -skipsafenet option, which skips the
installation of SafeNet:
./setup_visualcobol_devhub_2.3_update1_platform -skipsafenet
To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:
touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL
While the file is present, the SafeNet installer does not make changes to the installation or shutdown the
running license daemons. If licensing needs to be updated later, remove the file and install Sentinel
RMS server manually.
Note:
During the installation process, the installer configures the product's Enterprise Server System
Administrator Process User ID. The Process User ID will be the owner of all Enterprise Server
processes except the one for the Micro Focus Directory Server (MFDS). The Directory Server process
(Enterprise Server Administration) runs as root as this allows it to access the system files and ports.
All Enterprise Server processes you start from Enterprise Server Administration run under the
Process User ID which can affects the file access and creation.
By default, the installer uses the login id of the user that runs the installer for the Process User ID. To
change the user id after you complete the installation, execute $COBDIR/bin/casperm.sh.

After Installing
•
•
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See Changes in Behavior or Usage in your product documentation and in the Release Notes for
important information about changes in this release that might affect existing applications.
Check the Product Documentation section of the Micro Focus SupportLine Web site and the Micro
Focus Infocenter for any updates to the documentation which might have been uploaded.

Licensing Information
Note:
•

•
•
•
•
•

When you activate Visual COBOL Personal Edition, you can use it for a limited period of 365 days.
After this period, you can either register a new Personal Edition license for 365 days or acquire a
valid license either for a 30-day trial or full license of Visual COBOL in order to continue using the
product.
This package provides eight licenses for using Micro Focus Development Hub on all platforms.
If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.
Personal Edition licensing is only available with Visual COBOL for Visual Studio 2015 and Visual
COBOL for Eclipse
The latest version of the SafeNet licensing software is required. See the Software Requirements
section in this document for more details.
Your entitlement for using this product is governed by the Micro Focus End User License
Agreement and by your product order. If you are unsure of what your license entitlement is or if you
wish to purchase additional licenses, contact your sales representative or Micro Focus
SupportLine.

To buy and activate a full unlimited license
To buy a license for Visual COBOL, contact your sales representative or Micro Focus SupportLine.
For instructions on using the Micro Focus Licensing Administration Tool, see Licensing in the Visual
COBOL help.

To start Micro Focus License Administration
Windows
From the Windows Taskbar click Start > All Programs >Micro Focus License Manager > License
Administration.
Note: On Windows 8, Windows 10, and Windows Server 2012, you use the Start screen to invoke
programs.
UNIX
Log on as root, and from a command prompt type:
/var/microfocuslicensing/bin/cesadmintool.sh
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Installing licenses
If you have a license file
Windows
1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:
•

Click Browse next to the License file field and select the license file (which has an extension
of .mflic).
• Drag and drop the license file from Windows Explorer to the License file field.
• Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file
into the box below the License file field.
4. Click Install Licenses.
Alternatively, you can install the license file from within the IDE as follows:
1. Start Visual COBOL.
2. Click Help > Micro Focus Product Help > Product LicensingHelp > Micro Focus > Product
Licensing to open the Product Licensing dialog box.
3. Ensure I have a full Visual COBOL license is checked.
4. Click Browse next to the License file field.
5. Select the license file (which has an extension of .mflic), and then click Open.
6. Click AuthorizeFinish to install the license.
You should see a dialog box with a confirmation that the licenses have been installed successfully.
UNIX
1. Start the Micro Focus License Administration tool and select the Manual License Installation option by
entering 4.
2. Enter the name and location of the license file.

If you have an authorization code
Authorizing your product when you have an Internet connection
The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.
Windows
1.
2.
3.
4.

Start Micro Focus License Administration.
Click the Install tab.
Type the authorization code in the Enter authorization code field.
Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.
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UNIX
1. Start Micro Focus License Administration.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter.

Authorizing your product when you don't have an Internet connection
This method of authorization is required if your machine does not have an Internet connection or if normal
(automatic) authorization fails.
Windows
1.
2.
3.
4.

Start Micro Focus License Administration.
Click Manual Authorization on the Install page.
Make a note of the contents of the Machine ID field. You will need this later.
Do one of the following:
•
•

If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.
If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus SupportLine Manual product authorization Web page is displayed.
5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character
alphanumeric string supplied when you purchased your product.
6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License
file field on the Install page.
10.Click Install Licenses.
UNIX
In order to authorize your product you must have the following:
•
•

Your authorization code (a 16-character alphanumeric string).
The machine ID. To get this, start the Micro Focus License Administration tool and select the Get
Machine Id option by inputting 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.
1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.
2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.
3. Click Generate.
4. Copy the licenses strings from the web page or the email you receive into a file.
5. Put the license file onto your target machine.
6. Start the Micro Focus License Administration tool and select the Manual License Installation option by
inputting 4.
7. Enter the name and location of the license file.
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To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for Visual
COBOL, contact your sales representative or Micro Focus SupportLine.
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Updates and SupportLine
Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.
The product support pages contain a considerable amount of additional information, such as:
•
•
•

The Product Updates section of the Micro Focus SupportLine Web site, where you can download fixes
and documentation updates.
The Examples and Utilities section of the Micro Focus SupportLine Web site, including demos and
additional product documentation.
The Support Resources section of the Micro Focus SupportLine Web site, that includes troubleshooting
guides and information about how to raise an incident.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page, then
click Support.
Note: Some information may be available only to customers who have maintenance agreements.
If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.
Also, visit:
•

•

The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See http://community.microfocus.com.
The Micro Focus YouTube channel for videos related to your product - see https://www.youtube.com/
user/MicroFocusIntl.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.
•
•
•
•
•
•

The name and version number of all products that you think might be causing a problem.
Your computer make and model.
Your operating system version number and details of any networking software you are using.
The amount of memory in your computer.
The relevant page reference or section in the documentation.
Your serial number. To find out these numbers, look in the subject line and body of your Electronic
Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.
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Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a
tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.
On Windows, you can use the Micro Focus SupportLine Support Scan Utility, MFSupportInfo, to create
either:
•
•

a .log file that contains the details about your environment, Micro Focus SupportLine products, and
settings.
a .zip archive that includes the same information as the .log file plus some product configuration
files from c:\ProgramData and the product installation log files.

MFSupportInfo.exe is stored in <install-dir>\bin.
To run MFSupportInfo:
1. Start a 32-bit Enterprise Developer command prompt.
2. Enter MFSupportinfo at the command prompt to start the utility.
3. Create a .log file or a .zip archive as follows:
a. To create a .log file, click File > Save.
This prompts to save the .log file, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MMSS.log, in the %temp% directory.
b. To create a .zip archive, click Tools > Create Zip Package.
This creates a .zip archive, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MMSS.zip, in the %temp% directory.
4. Send the diagnostic information to your Micro Focus SupportLine representative:
The following requires an Internet connection and an Email client:
a. Click Tools > Email Log to SupportLine to open the Email Log dialog box.
b. Fill in the required fields and click Send.
If the machine is not connected to the Internet or if there are no Email clients installed, copy either
the .log file or the .zip archive to a machine that is connected to the Internet. Use your Email client
to email the files to Micro Focus SupportLine at supportline@microfocus.com together with the Support
Incident (SI) number, if available, and any additional details that might be useful to diagnose the issues
that you are experiencing.
On UNIX, you can use the Micro Focus UNIX Support Scan Utility, mfsupport, to create a log file that
contains the details about your environment, product, and settings. The mfsupport script is stored in
$COBDIR/bin.
To run mfsupport:
1. Start a UNIX shell.
2. Set COBDIR to the product with issues.
3. Execute mfsupport from a directory where you have write permissions.
This creates a log file, mfpoll.txt, in that directory.
4. When the script finishes, send the mfpoll.txt file to your Micro Focus SupportLine representative.
Note:
If COBDIR is set to a location that does not contain etc/cobver, the script outputs the contents
of /opt/microfocus/logs/MicroFocusProductRegistry.dat which keeps a list of the
installed Micro Focus products.
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Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
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Disclaimer
This software is provided "as is" without warranty of any kind. Micro Focus disclaims all warranties, either
express or implied, including the warranties of merchantability and fitness for a particular purpose. In no
event shall Micro Focus or its suppliers be liable for any damages whatsoever including direct, indirect,
incidental, consequential, loss of business profits or special damages, even if Micro Focus or its suppliers
have been advised of the possibility of such damages. Some states do not allow the exclusion or limitation
of liability for consequential or incidental damages so the foregoing limitation may not apply.
Micro Focus is a registered trademark.
Copyright © Micro Focus 1984-2016. All rights reserved.
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